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Welcome
3 essential skills  

you will learn 
in this issue

01 UNDERSTAND 
SHOOTING MODES
Turn to p12 and master your 
camera’s settings today

02 ENHANCE YOUR 
LANDSCAPES
Top editing techniques for 
stunning vistas on p30

03 PREP FOR PRINT
Over on p36 we show you 
how to optimise your shots for
great prints 

Getting a new camera out of the box can be an 
exciting yet nerve-wracking thing. When you’re not 
sure of the basics, it’s hard to know the best 
ways to put your kit to good use, but we are 
here to help this issue. Turn to p12 to learn 
everything you need to get your camera from 
box to taking great shots. We also have a useful 
feature on p20 that guides you through how to 
improve your food snaps on your phone, and a 
5-minute project on p26 that tells you how to 
incorporate props into portraits for fun effect. 
Also check out our review of the Panasonic 
LUMIX GM5 on p44 for those still thinking of 
upgrading. I hope you enjoy the variety of 
advice on offer this issue.

Amy Squibb
Editor in Chief
Follow us at @PFBMag

WELCOME
Issue 46Re-create 

this look on
Page 24
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Your photos
Enjoy and be inspired by this showcase of absolutely 
stunning images sent in by our readers this month

Boats at Alnmouth
“Boats near the mouth of the River Aln 
in Northumberland with Church Hill in 
the background. Captured shortly 
before sunset near the end of June.”
Shot on: Canon EOS 5D Mark II, with 
17-40mm lens @ 31mm, f19, 1/30sec, 
ISO 400 and a Lee 0.6 (Hard) ND 
Grad fi lter

Reader: Andrew Ray

6    Photography for Beginners
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WIN!A Samsung 32GB memory cardEvery issue, one winner will receive a 

Samsung 32GB EVO SDHC memory 

card or a prize of equal value
www.samsung.com/uk

Full terms and conditions  
available online

Share your shots at: photoforbeginners.com Photography for Beginners    7
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Readers’ gallery



Reader: 
Leslie Rose
Rufford Robin
“Standing on a viewing 
platform at Rufford 
Park, down fl ew this 
robin on to the tree just 
in front and stayed 
there for a while as if 
posing for the photo.”
Shot on: Nikon 
D5000 @ 200mm, ISO 
800, f5.6, 1/1000sec

Reader: Benjamin Day
Off into the Sun

“This shot was taken in Ringwood 
forest. I wanted to incorporate my bike 

into the shot somehow, [as I was] trying 
to achieve the feeling of adventure 

during a low sun.”
Shot on: Nikon D5100 with 

18-55 kit lens @ 35mm, f14,
 1/160sec, ISO 160

Reader: Jessica Davis
Autumn Eyes
“I was doing a photo shoot with my 
son, when this kitten trotted in.”
Shot on: Canon EOS 1100D with 
18-55mm lens @ 18mm, f7.1, 
1/160sec, ISO 400

Reader: Rich Renton
Acoustic Paint

“Set up on the work bench in my shed, I 
used a speaker and some of the kids’ 

poster paint; when loud music was played 
through the speaker the paint leapt in to 

the air and I pressed the shutter.”
Shot on: Canon EOS 550D with 18-55mm 
lens @ f11, 1/200sec, ISO 200 and fl ash 

set to 1/64th power

YOUR PHOTOS
Readers’ gallery
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Reader: Teresa Burdis
Title: Mevagissey 
Harbour

Reader: Marie Savage
Title: Window Rock, 
Sark

Reader: 
Carlo Provencio

Elijah in the Grass
“I took this photo of my son 
after he sat down and said 

‘Dad, take a picture of me!’ I 
was really surprised because 

he normally doesn’t like to 
pose for pictures.”

Shot on: Nokia 
Lumia 1520

Share your shots at: photoforbeginners.com

Win cameraphone
Send us your cameraphone shots and you could win a Manfrot
KLYP kit worth £95/approx $150. For more info head to www.
manfrotto.co.uk. Full terms and conditions available online.

ENTER NOW: Send your shots to pfbteam@imagine-publishing.co.uk

Photography for Beginners    9



Share on our social sites Join the Facebook, Twitter and Flickr communities

@PFBMag
Click the Tweet box and select Add Photo. Find
your shot and click Open. Write some text,
include @PFBMag, then click Tweet and we will
see your photo.

PFB Magazine
Hit Upload to add images. Go to the image you 
want to share, click on the Share icon and
highlight the Link. Email it to pfbteam@
imagine-publishing.co.uk.

PFBMag
Search for ‘PFBMag’ and click the tab. On our
page, hit Photo/Video, then Upload Photo/
Video. Browse for your image, write a message
and click Post for it to appear on our wall!

Also share on our website Head to www.photoforbeginners.com now

Read free tutorials
There are a wide variety of free
guides online. Simply search for a
subject here or click on the
Tutorials tab to browse.

Become our favourite!
We pick our favourite shots to 
highlight in our Featured Image 
section. This could be you soon, 
so get uploading!

Create a gallery
You can showcase your favourite
images by creating your own
gallery page on our website. It’s
quick and simple to set up.

Enter the
Face-Off
Your shots are
entered into our
Face-Off
section and
pitted against
other people’s
– have fun
watching your
score rise!

Be inspired
Browse through all the different
categories to be inspired by
other readers’ photos and get
ideas of your own.

10 Photography for Beginners

SHARE YOUR SHOTS
Here’s how to show us your stunning snaps

Share your shots at: photoforbeginners.com

http://www.photoforbeginners.com
mailto:pfbteam@imagine-publishing.co.uk
mailto:pfbteam@imagine-publishing.co.uk
http://photoforbeginners.com
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MASTER YOUR

CAMERA
Top tips and tricks to get you from 
box to great shots in no time at all

12    Photography for Beginners
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When you get a new camera, it can initially
be daunting trying to get to grips with all
that’s involved. Don't settle for a life on the
Auto setting, though; we are here to help you
conquer any teething problems with an easy
to follow guide to the most important factors
you need to know.

First of all you need to get set up. Ensure
you fully charge the battery before you get
stuck in and insert a memory card (your
manual will tell you what type you need). If
you have an interchangeable lens camera

you will need to attach the lens and it’s
always a good idea to attach a strap – lift
your camera in front of you with your elbows
bent to 90 degrees and your camera strap
should pull tight and be no longer. If you have
an optical viewfinder, please ensure you
rotate the dioptre next to it until the scene in
front of you comes into focus.

Now it’s time to delve into the menu!
Begin with setting the time and date, boost
the brightness, then format the memory
card. This improves the card’s performance

and connects it to the camera, but make
sure there aren’t any files you wish to keep
as it wipes it clean! The last thing to do is
select your image size. Ideally you want to
set it to the highest quality setting, as you
can always downsize later. If you’re au fait
with Raw then you can set it to this but we
advise you stick with JPEG when initially
starting out. Read on as we take you through
the next stage – getting to grips with
shooting modes and your camera’s most
essential settings.

THE KEY SETTINGS AT A GLANCE

Grip the camera with onehand and then use the otherhand to ‘cup’ the lens bysupporting it underneathwith your fingers.

Hold the cameracorrectlyShutter speed
Your shutter speed controls how fast
the shutter opens and closes. A fast
shutter speed (above 1/125sec) helps
to freeze action, while a slower speed
will blur movement.

Shooting modes
We used Shutter Priority to control the
shutter speed, but in Aperture Priority,

you set the aperture. Use a low
f-number for a small area to be sharp;
a high f-number keeps more in focus.

ISO
Your ISO controls how sensitive the
sensor is to light, so increasing it will
brighten shots. Where possible, keep
this as low as you can to avoid noise

appearing in your images.

Metering
This icon shows the metering mode

that has been selected. This
determines which area of the scene
the camera uses in order to set your

exposure value.

The meter dial
Use the meter dial to get

accurate exposures when using
Manual mode. The line below

should be in the middle like it is
here for accurate exposures.

Get up and running with this quick start guide to the essentials

SHOOTING
Master your camera in 24 hours

Share your shots at: photoforbeginners.com Photography for Beginners    13



Understand your shooting modes

Auto mode is a safe haven for budding beginners but it 
doesn’t offer you any creative control over the outcome of 
your images. Don’t be afraid to explore your camera’s 
mode dial and try out its other offerings, including scene 
modes, semi-automatic and full manual control.  

Scene modes are a great starting point as the camera 
still takes care of the exposure for you but each one is 
designed to select the best settings based on the type of 
shot you want to achieve. Semi-automatic, Program, 
Aperture and Shutter Priority mode all give you much more 
control over your exposure settings and other important 
features such as white balance and ISO. Manual mode, on 
the other hand, will give you full control of the camera, so 
you can really get creative with exposure and a wealth of 
other great effects.

Check out our guide to a camera’s shooting modes here 
and work your way around the mode dial to discover which 
setting is right for your next shot. 

Use the mode dial and 
shooting modes to 
instantly take better shots  

Switch to Manual mode (M) for
complete control over yourcamera settings. You can experiment with different 

combinations of aperture and
shutter speed for varied andcreative effects.

Go Manual

In Shutter Priority, Aperture Priority or Manual, you can take control of the ISO. Find out 
how it can help you when hand-holding the camera in low light over on p16.

PLAY WITH ISO

Let the camera take care of the 
settings for you by selecting a 
scene mode on the mode dial. 
Simply choose one that 
accurately refl ects the type of 
shot you want to take. We chose 
a Sunset scene mode here to 
enhance the warm, orange tones.

SCENE MODES

SHOOTING
Master your camera in 24 hours

14    Photography for Beginners



Aperture Priority mode is represented by A or Av on the mode dial. In 
this mode you can select your preferred aperture setting whilst the 
camera determines the correct shutter speed for you. Use this mode to 
control depth of fi eld in your photos, which essentially means you can 
manipulate the amount of blur in the background. 

Wide apertures (small f-numbers of around f1.4-f5.6) are great for still 
life and portraits as they create a shallow depth of fi eld, enabling you to 
isolate a subject and blur out a busy background. When shooting with a 
wide aperture, though, be careful with your focusing, as you have a 
limited amount of the shot in focus. Small apertures (large f-numbers of 
around f8-f22) on the other hand are good for landscapes as they 
increase depth of fi eld so that more of the scene appears sharp. This is 
a really useful mode to help you transition into using full Manual mode. 

Program mode is really your first step towards taking control of your 
camera settings. Rotate the mode dial around to P to use this semi-
automatic mode. The camera will still determine the best aperture and 
shutter speed for the scene but you can adjust one or the other, if for 
instance you would like to use a wider aperture or slower shutter speed. 
The camera will then reconfi gure the settings to work around your 
preference. You can also adjust other settings in this mode such as 
white balance, metering and ISO.

Switch to S or Tv on the mode dial to take
control of your shutter speed with the 
semi-automatic, Shutter Priority mode. It 
works in a similar way to Aperture Priority 
mode as you can adjust your shutter speed
setting whilst the camera selects the correct
aperture for you. Set fast shutter speeds 
(1/125sec and upwards) to freeze action 
shots or prevent overexposed images in 
bright light. Slow shutter speeds (1/100sec
and below) can be used if you’re shooting in
low light, or want to capture a sense of 
motion in your shots. As a rule, however, 
always ensure you set your camera up on a 
tripod if you’re shooting below 1/80sec so as 
to prevent blurry, out-of-focus images.

Use wide apertures to blur out the 
background so that the main 
subject appears as the focal 
point within the frame.

Increase depth of 
fi eld with small 
apertures so that 
more of the scene 
appears sharp and  
in focus.

Wide aperture

Small 
aperture

SHUTTER PRIORITY MODE

Fast shutter 
speeds
Use fast shutter 
speeds to freeze 
action, such as falling 
water and kids at play.

Slow shutter 
speeds
Slow shutter speeds 
add a sense of 
motion and are great 
for blurring moving 
water in landscapes. 
They also help to 
ensure an even 
exposure in low light.

APERTURE PRIORITY MODE

PROGRAM MODE

Share your shots at: photoforbeginners.com

SHOOTING
Master your camera in 24 hours
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Enhance
exposures
Use the following settings to
enhance lighting in images

Although aperture and shutter determine how
much or how little light is captured in your
images, there are other camera settings that
can also affect the way in which light is
recorded. Check out our quick guide to some 
of the important settings and discover how 
and why you should be using them.

White balance
Prevent warm or cool colour casts by changing the 
white balance setting to refl ect the lighting you’re 
shooting under. It works by neutralising the effects 
of certain colour temperatures of light. 

ISO 
This controls the camera’s sensitivity to light. You 
may need to increase an ISO setting in low light to 
avoid slower shutter speeds. Be wary, though, as 
this can introduce noise into your images. 

Takecreative control

Once you select the best shooting mode
for your next shot, you’ll need to fine-tune
other camera settings so as to guarantee
great results. Metering, focus, white
balance, ISO and flash can all play an
important part when it comes to taking
fantastic photos. And although not all will
necessarily need to be adjusted for every

image you take, it’s still important to really
understand how they work and when you
need to use them.

We’ve outlined some of the most
important settings for you here. Discover
how they can help to improve your
exposures or even enhance creative
effects you want to achieve.

Discover the importance of other settings 
and how they can affect your photos

INCORRECT

You can capture fantastic
close-ups of any subject
with your camera’s macro
setting enabled.

MACROMODE

CORRECT

SHOOTING
Master your camera in 24 hours
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Master the 
focusing modes

Manual focus
This gives complete control. Rotate the
focus ring around the lens to use it and
rely on your senses to know when your
subject is really sharp.

Automatic focus  
This default AF mode can be pretty 
accurate and is useful if you want to take 
a quick shot. Set Al Focus or AF-A and the 
camera will lock onto an obvious subject.

Metering modes
It’s important to select the correct metering mode in
order to get an even exposure. Use Spot and Partial
for backlit subjects and Centre-weighted or
Evaluative to encompass more of the scene.

Flash
Flash is not always necessary with wider apertures
or higher ISOs but it is useful to freeze action or
illuminate a subject in low light. Try slow sync to
incorporate more of the ambient background.

Capture pin-sharp shots 
with the correct mode

If you want to capture a detailed macro close-up, switch
on your camera’s Macro setting. This specialist mode
will enable you to focus much closer to your subject with
your existing lens. For even closer captures, use a
macro filter, extension tube or a specialist macro lens.

MACRO PERFECTION

The single point AF 
mode (One-shot AF 
or AF-S) enables 
you to position your 
focus point over 
one area of the 
image. It’s best for 
stationary subjects 
and works well for 
portraits if you 
position the point 
over the eyes.

Single point AF

AF-C or Al Servo AF 
represents 
continuous focus. 
Use this to keep 
moving subjects 
sharp; great for 
pets or sports. 
Once you lock 
focus on your 
subject, the 
camera will track 
its movements.

Continuous AF

Share your shots at: photoforbeginners.com

SHOOTING
Master your camera in 24 hours
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“Your family portrait won’t be
complete if you’re not in it too”

Occasions when everyone is together offer the optimum
opportunities to capture family portraits, but taking the perfect
shot can sometimes be a challenge. It’s best to prepare and
get set up beforehand to prevent your subjects from losing
interest, particularly if young children are involved. Follow our
tips to find out how.

Get everyone together for a family 
photo you can cherish forever

5 tips for great family 
portraits

Select your settings
When picking your settings, either use a 
portrait scene mode, or switch to aperture 
priority. Select a mid-range aperture, 
around f5.6, to keep everyone in focus but 
still create some background blur. The 
shutter speed needs to be fast to prevent 
any motion blur.  

Sharp faces
When focusing the shot, see if your 
camera has a face detection option 
that will automatically keep everyone’s 
face sharp for you. If it doesn’t, use 
selective autofocus and focus 
on the person who is at the 
front of the shot. 

Another level 
When getting everyone into position, make 
sure that all their faces are visible. Try to 
make use of different levels, getting some 
people to sit and others to stand, so 
everyone is not just in a straight line. 

Get in the shot
Your family portrait won’t be complete if 
you’re not in it too. Therefore set the 
camera on a tripod and use self-timer mode 
so that you have enough time to run into 
shot before it’s taken. 

No blinking
To make sure everyone is smiling and has 
their eyes open in the photo, use burst 
mode to take a series of shots so you can 
pick the best. Alternatively, your camera 
may even have a blink detection mode. 

Share your shots at: photoforbeginners.com

SHOOTING
Quick tips
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A Samsung 
NX Mini
Plus three lucky runners-up will each get a 
Samsung 16GB EVO microSD memory car

Samsung’s NX Mini is an ultra-slim 
and stylish Compact System 
Camera that will easily slip into 
your pocket. The handy fl ip-up LCD 
screen is perfect for framing selfi es 
with ease, and Wink Shot mode will 
automatically take the picture a few 
seconds after it detects you winking 
at the camera. 

Tag & Go connectivity lets you 
wirelessly connect the NX Mini to 
your smartphone, instantly 
transferring shots to your device for 
online sharing. Meanwhile, 

MobileLink allows you to share 
photos and albums with up to four 
friends with the tap of a button. 

For a chance to win this fantastic 
camera, enter our competition now!
The winner and runners-up will also 
receive one of Samsung’s brand-
new 16GB EVO microSD cards that 
can store thousands of photos, and 
boasts ultra-high-speed 
performance for capturing images 
and transferring them to PC quickly. 
To fi nd out more, visit the website 
at www.samsung.com. 

Terms and conditions
This competition is open to residents of the United Kingdom and Ireland. 
Imagine Publishing has the right to substitute the prize with a similar 
item of equal or higher value. Camera colours may vary. Employees of 
Imagine Publishing (including freelancers), Samsung, their relatives or 
any agents are not eligible to enter. The editor’s decision is fi nal and no 
correspondence will be entered into. Prizes cannot be exchanged for 
cash. Full terms and conditions are available on request. From time to 
time, Imagine Publishing or its agents may send you related material or 
special offers. If you do not wish to receive this, please state clearly on 
your competition entry.

HOW TO ENTER:
Send your name, contact details and your 
best shot to us by 05 February 2015.
Email: pfbteam@imagine-publishing.co.uk
Website: www.photoforbeginners.com

PLUS!A 16GB Samsung memorycard

WIN!

Photography for Beginners    19
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Stand out from the 
Instagram crowd with 

properly composed and 
lit food images that you 

can photograph with 
your cameraphone

Get great
food snaps

with your
phone

We’ve all seen a million photos on 
social networks of people’s lunch. But, 
done properly, food photography can be 
a fantastic subject to work with. And 
best of all, you don’t necessarily need 
any fancy equipment to get started with 
food photography – the camera on your 
phone is a suitable tool for getting some 
great shots if you know how. 

In this guide we’ll walk you through 
some essential tips for composition, 
lighting and making the most of props 
for superb food images. Before you 
know it, yours will be standing out from 
the crowd on Instagram. 

Choosing what to photograph is the 
first difficult decision to make, but it 
makes sense to start with cold food. 
That way you don’t have to worry about 
keeping it hot… and you can eat the 
props afterwards even if you’ve spent 
an hour photographing it, which is 
always a bonus. 

Look out for subjects with lots of 
colour and that will look attractive in 
your photo. Fruits, cakes and sweets all 
make great subjects. 

It’s also worth thinking about where 
you’re going to shoot your photos. Pick 
somewhere with lots of light – next to a 
window is ideal. If your kitchen is a bit 
dark, move to a room which has light 
and set up a mini home studio.

Natural lighting is best for food photography, 

so try and place your props near a window 

and photograph during the day if you can

SHOOTING
Get great food snaps with your phone
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Right
Try positioning your subject

in the centre of the frame
– switch to using a square

format if it seems to suit
the subject

Composition tricks
Food looks good if you shoot at its
own level, or directly from above. Try to
avoid angled shots from where you’re
sitting at the dinner table, but instead,
move the camera down so it’s directly
facing the food, or place it above so it
is exactly on top of it.

You also want the food to be the
main focus of the image, and this
means getting rid of distracting
elements from the

frame. Shooting from above helps to
do this as you won’t suffer from any
ugly distractions lurking in the
background of the shot.

Don’t be afraid to get close for more
abstract shots too; these work well as
part of a collage, or group of shots
and help to show off texture and fine
detail. Experiment with how close your
phone can get to the food while

maintaining focus – you
may find you need to
force the camera to
refocus by tapping on
the screen.

Get the best angle for your food shots

Another distracting element can be if your
food is sitting on an ugly plate, or there’s
something in the background taking the
focus away from the food.

It’s relatively easy and cheap to remedy
this problem by keeping an eye on your
props. If you don’t have anything suitable in
your kitchen cupboards, keep an eye out for
cheap items in charity shops and car boot
sales. Also, simple white plates, often the

cheapest items available in every
supermarket, allow your food to be
the star of the shot.

Think about the background of your
shot, too. Sometimes a nice kitchen
or dining room setting works really
well, but if your house doesn’t
represent something out of an interiors
magazine, using a simple piece of
wrapping or art paper can leave you
with a vibrant background for just a

couple of pounds.

Left
Shoot from directly above
for a flattering angle as
well as reducing any
unwanted distractions

Working
withprops
Consider what is
surrounding your food to
ensure shots with impact

You want the f main focus point ofthe shot, so keep props simple and backgroundsnon-distracting. Look for colours which emphasisethose in the food.

SHOOTING
Get great food snaps with your phone

Share your shots at: photoforbeginners.com Photography for Beginners    21



Best settings for
food photography
Discover how to make the most of your phone settings and
ensure that you get the optimum results

Adjust brightness
Get the perfect exposure by increasing or decreasing the
brightness. Using iOS 8, tap the screen to set a focus point,
then move the slider up and down to adjust brightness. For
Android users you can make image adjustments in the menu.

HDR on or off
Switch the HDR setting off for natural-looking shots. However
in tricky lighting situations, switching it on can help to even
out exposures. Leave it on Auto if you’re not sure, as the
camera is usually pretty good at judging its best use.

When you use a digital zoom 
on a phone the quality can be 

poor. It is effectively just 
cropping into the photo so just 
use your feet and get closer. 

You can always crop in further later 

Avoid the zoom

Aspect ratio
Choose between standard 4:3 aspect
ratio and 1:1 square ratio from the
menu. Your subject will dictate which is
best, but bear in mind that Instagram
shots are always square.

Foodie apps
Share and edit
your food photos

Instagram
Price: Free Available on:
iOS & Android
Instagram has a bunch
of editing tools for
making quick and
creative edits. Add
hashtags to share your
photos with like-minded
foodie snappers.

ProCamera 8+
Price: £2.49/$3.99
Available on: iOS
Take better control over
photographs with
ProCamera 8 which
allows you to change
things such as exposure,
ISO speed and tint. This
version is designed to
work best with iOS 8.

Snapdish
Price: Free Available on: 
iOS & Android
Take inspiration from 
other users’ photos and 
post your own with this 
simple app. Easily 
connect with your 
friends and family by 
posting to Facebook, 
Twitter and more.

Switch off flash
Avoid using the flash, or you’re likely to
end up with unnatural colours and
unappetising images. Tap the flash icon
and switch from Auto to Off. Shoot in a
well-lit environment for best results.

Timer 
To avoid camera shake in low light, fi nd 
something to stand your phone against, 
or invest in a phone tripod. You can also 
select the timer so you don’t create 
shake when you press the shutter.

Use fi lters 
To enhance your images, why not try 
adding a fi lter – some work well for food 
shots, while others don’t work at all. 
Experiment with all the options to fi nd one 
that works best with your image; on iOS, 
Chrome and Instant are good options to 
begin with for instance.

SHOOTING
Get great food snaps with your phone
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Open your image

01Choose the image that you
want to work on by tapping

the plus icon in the corner of the
screen and then scroll through
your image library to choose the
best photo. You can see a
preview of the image before you
open it to make sure it’s the
correct one.

Make basic changes

02Click Fine Tune to make
small changes. Swipe up

and down to change between
options, then swipe right and left
to increase or decrease the
setting. Here we’ve boosted
Brightness, Saturation and
Contrast by around +10 to give
the image a little more punch.

Crop and Straighten

03If you don’t think you got
the composition quite right,

use the Crop and Straighten tools
to improve it. In Straighten, simply
move the image around the box
until it is in the position you need.
With Crop, either use free
cropping or be constrained to
aspect ratios, such as 1:1 or 3:2.

Add extra touches

04To get a little more
creative, apply one of the

filters or frames to your image.
You can adjust the intensity of the
filter by swiping right or left – not
every one will work well with your
food shots so it’s worth
experimenting to see which looks
best. Add a frame if you like.

Give your imagesextra pop
byeditingwithSnapseed
Improve images using this free but powerful image-editing app Price: Free Available on: iOS & Android

Cameraphoneaccessories
Get even more serious with these great accessories for your phone

Macro lens
Price: £12/$20
Ensure you are able to get closer to
your subject with a dedicated macro
lens for your phone, available from
quirky store photojojo.com. This is
particularly good for finely textured or
detailed foods, but will add sharpness
to almost every shot.

GorillaPod GripTight
Magnetic
Price: £25/$15
Make sure your food shots remain
free of blur and get the perfect
composition by using a tripod. This
one from joby.com is perfect as you
can attach the tripod to a variety of
different surfaces.

The Pocket Spotlight
Price: £19/$30
Another great piece of kit from
photojojo.com, this pocket spotlight
helps if you can’t avoid shooting in the
dark – particularly useful for evening
meals or when photographing food at
a restaurant. It simply plugs into your
phone’s headphone socket.

Lastolite 30cm Reflector
Price: £12.50/$12.95
Extremely handy for directing light to
get an even look, silver reflectors will
add a neutral, slightly cool cast, while
gold reflectors will reflect warm tones.
Exactly which one is best usually
depends on the subject. Get more
information at lastolite.com.

SHOOTING
Get great food snaps with your phone
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Capture a breath-taking vista with a silky smooth water effect

Coastal landscapes

WHATYOU’LLNEED…
Digital camera
Tripod
Neutral density filter  

WEUSED…
Canon EOS 100D

Aperture: f11
Shutter speed: 15sec
ISO: 100

YOUCOULDUSE…
Any digital camera
Sturdy surface

SHOOTING
Create this shot!
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CREATE THIS SHOT! 

FIND A LOCATION
Coastlines are often
naturally spectacular,

but instead of just shooting
the water disappearing off 
into the horizon, include some 
foreground interest in your 
shot too. A lighthouse or 
people will work well.  

TIME OF DAY
As well as casting a
golden light across the

scene, shooting at dawn or
dusk will also allow you to use
slower shutter speeds as the
conditions are darker.

BE PREPARED
Before heading out, check 
the tide times to ensure you 

wont get stranded, and track the 
sunrise and sunset times to make 
the most of the natural light. 



SHOOTING
Create this shot!

Photography for Beginners    25

MINIMISE 
SENSITIVITY

As you will be using a 
slow shutter speed, 

keep your camera’s ISO value 
as low as possible for the best 
image quality. 

Share your shots at: photoforbeginners.com

3 OF THE BEST…
Methods for 
a smooth 
water effect

Filter fi nish 
Attaching a neutral density fi lter will allow you to 
use slow shutter speeds in daylight without 
producing an overly bright shot.

Mode selection
Switch to manual mode and opt for a slow shutter 
speed to blur the moving water. Also choose a 
narrow aperture (large f-number) to keep 
everything in focus.  

Tripods are essential
When using slow shutter speeds, you will need to 
secure your camera to a tripod to prevent camera 
shake and a blurry photo.

CREATIVE COMPOSITION
Position the horizon towards the 
top third of your photo to really show 

off the silky smooth water effect, or move 
it lower if the sky is more interesting. 

PROTECT YOUR KIT
Keep your camera on a 
strap to avoid dropping it 

into the sand or salt water, and 
rinse off your tripod when you get 
home to prevent rusting. 



SHOOTING
Utilise props when shooting portraits
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Accessories
for portraits

Pocket refl ector 
Help direct light to your subject’s face using this 
highly portable refl ector from photojojo.com, 
which includes a silver side and a white side. 

50mm f1.8 lens
Create really blurry backgrounds at a reasonable
cost by picking up a 50mm f1.8 lens like this one
from Canon, for just around £100.

3 OF THE BEST…

Remote release 
Pick up a remote release like this one from 
Hähnel and turn the camera on yourself. You’ll 
learn lots about composition and posing.



Add a little fun and character to your people shots
by experimenting with different props

Utilise propswhen
shootingportraits

WHAT YOU’LL NEED…
Any camera

A lens (a focal length

50mm or more is ideal)

A prop of some

description

WE USED…
Canon EOS 60D, 50mm

f1.4 lens

YOU COULD USE…
Any camera

A kit lens

five
minute
project

Shoot in the right mode

01Set your camera to Aperture Priority mode as this
gives you control over how blurred the background

will be. Shutter speed is set automatically. It might be
called Av, or simply A on your camera. If you don’t have this
mode, pick the Portrait scene mode.

Set the aperture

02You want a nice wide aperture that will
throw the background out of focus. For

really blurry backgrounds, set aperture to its
widest setting (usually between f1.8 and f5.6).
For more focus, though, keep it at f5.6.

Select the ISO

03Detail is important with portraits, and
you’ll want to shoot at as low an ISO as

possible. If you’re outside in good light, 100 or
200 should do the trick. If you’re inside and
it’s a little darker, try to keep below ISO 800.

Pick a Picture Style

04For best colours in JPEG images, set
the Picture Style (Canon) or Picture

Control (Nikon) to Portrait. This gives great
skin tones, but you can also shoot in Raw
format if you want to tweak post-capture.

A great way to make portraits feel more
relaxed is to use props. These are also great if
the person you’re photographing doesn’t have
much experience modelling, as it will give them
something to interact with. You can ask your
friends and family if they will pose for you, or if

not you can often find models who are willing to
work for free in exchange for high-resolution
prints using websites such as Model Mayhem
or StarNow.com.

All kinds of props work well for portraits, and
you can use things that you have to hand. It’s

even better if the prop is something that has
significance to your model.

If you can, get hold of a fixed focal length
lens – a 50mm f1.8 lens is affordable. But you
can also get good results with your kit optic.
Just shoot at a longer focal length, though.

Play with props Follow these steps to achieving a perfect prop portrait

Choose a focus point

05Use Single AF mode and move the
focus point over their eyes. If you don’t

have this option, position the eyes in the
middle, half press the shutter, then
recompose before fully pressing down.

SHOOTING
Utilise props when shooting portraits
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Convert to monochrome

01 Select Black & White from the ‘Create 
new fi ll or adjustment layer’ tab at the 

bottom of the Layers palette. In the dialog box,
adjust the coloured sliders to enhance the 
tonal contrast within the image.

Apply a sepia tone

02 Select Solid Color from the adjustment
layer tab at the bottom of the Layers 

palette. In the Color Picker dialog box, select a
warm sepia tone by scrolling through the 
colour hues and then click OK.  

Blend the results

03 Click the Solid Color layer and select 
Overlay from the blending mode menu 

at the top. Now use the Opacity slider on the 
right to lessen its strength. Go to 
Layer>Flatten Image and then save.

Transform colour captures 
into artistic sepia shots 
with Photoshop

Add a 
sepia tone

Easy sepia How to add a fantastic sepia effect to your images in Photoshop

Sepia is a fantastic 
alternative to black and 
white. In the darkroom days 
the effect was achieved by 
soaking the image in a 
toning solution but now it 
can be done on the 
computer. In this tutorial, 
we’ll show you how to give 
your photos an authentic 
sepia tone in minutes.  

For the best result you 
need a good start image 
with plenty of contrast so 
that the sepia effect can really stand out. The style suits any 
subject; be it a landscape, portrait, still life or street style 
shot. You simply open your colour capture within Photoshop. 

We’ll start by showing you how to convert an image to 
monochrome with the Black & White adjustment fi lter, 
before taking you through the necessary steps to apply and 
blend a realistic sepia tone on top. It’s a fantastic way to add 
a creative twist to your captures and you’ll soon see that you 
don’t have to be an editing expert to get great results.
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EDITING

WHAT YOU’LL NEED…
A good start image
 Editing software

WE USED…
Photoshop CS5

YOU COULD USE…
Photoshop CS/CC
Photoshop Elements
GIMP



Available
from all good

newsagents and 
supermarkets

facebook.com/PhotoshopCreative twitter.com/PshopCreative

CREATE THE IMPOSSIBLE
www. p h o t o s h o p c r e a t i v e . c o . u k

BUY YOUR ISSUE TODAY
Print edition available at www.imagineshop.co.uk

Digital edition available at  www.greatdigitalmags.com

PHOTO EDITING DIGITAL PAINTING  BEGINNER TIPS  TOOL GUIDES  PHOTO ART  

 Striking imagery  Step-by-step guides  Essential tutorials
ON SALE NOW

Available on the following platforms



Bring out the best in your landscape images with just
a few clicks in Photoshop Elements

Clone Stamp
Use the Clone Stamp
to clone parts of an
image to remove
imperfections or any
other distractions
in the shot

Enhance your landscapes

Smart Brush
The Smart Brush
performs a number of
enhancement
techniques with
nothing more than a
click of the mouse

Straighten
Make your images
level with the
Straighten tool. It
will even fill in the
gaps and enlarge
the image for you

Crop 
Shooting wide and 
cropping in is 
standard practice, 
and Photoshop 
Elements has features 
to help out here

Expert Mode
In earlier releases this 
is called Full. Don’t be 
put off by the word 
Expert; you really don’t 
need to be an expert 
to use it

Panels
Select different panels 
from this little menu 
at the bottom of the 
interface, including 
being able to see all of 
your image’s layers.
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EDITING
Enhance your landscapes

WHAT YOU’LL NEED…
 A selection of
 landscape images

WE USED…
Photoshop Elements 

YOU COULD USE…
Photoshop
Raw editor supplied with 

your camera



Stamp it down

04Move the mouse to what needs to be
fixed and click. You can ‘paint’ with

this as well as repeatedly clicking. For best
results, follow the shape of the clone area.
Here we’re following the curve of the hillside.
We’ll resample when we get to the roadside.

Build up areas

05 When cloning in Photoshop Elements 
it’s very easy to get a repeating 

pattern; this can be quite a distraction in itself
and is a sure-fi re sign of image editing. Build 
up textures slowly from sources around the 
area to make it more organic.   

Erase areas

06We worked non-destructively so by 
clicking the eye next to the new layer 

we can temporarily hide the cloning that we’ve 
done. If it went a little wrong, grab the Eraser 
tool and, staying on the new layer, erase the 
cloning to reveal the original image.

Use the Clone Stamp tool

02Pick the Clone Stamp tool and a soft 
brush that’s smaller than the item 

being removed. Select Sample All Layers; this 
will put changes on the new layer. Check 
Aligned to keep the source and clone aligned. 
Uncheck this later to see the difference.

Make a new layer

01We want to do everything non-
destructively, meaning we can return

to our original image later should we wish.
Working in Expert mode means we can do all
our alterations on a new, separate, layer. Click
the New Layer icon to add a layer.

Find a Source

03 Hold down the Alt (PC) or Option (Mac) 
key and move the pointer onto the 

image; the pointer changes to a crosshair for 
you to select a source for the clone. Click 
down and the area under the mouse becomes 
a brush. You can resample like this at any time.

Remove 
distractions
Clone out objects that you 
don’t want in an image

BEFOREAFTER

Share your shots at: photoforbeginners.com

EDITING
Enhance your landscapes
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Fill in the blanks

03When you rotate you may get
some blank canvas. If so, check

the Auto Fill Layers in the Options bar and
crop. With this checked, Elements will
assimilate the texture and colour of the
missing pixels and complete the scene.

Straighten up 
your images

Pick the Straighten tool

01 Hand-holding a camera can often 
lead to great shots, just on a slant. 

Photoshop Elements allows us to correct 
this, however. At the bottom of the Tools 
panel is a Straighten Tool; it looks like a 
spirit level.

Smart Brush Brighten up your sky

Pick the desired effect

02 Clicking the small arrow to the right of 
the image on the left opens up a new 

menu. Choose ‘Nature’ and then ‘Make Dull 
Skies Blue’. Set the brush size to suit your 
image; if in doubt, the default works fi ne.

Select the Smart Brush

01Smart Brush is an automated, but
non-destructive selection and

enhancement tool. Click it and a contextual
menu appears at the bottom of the screen.
The brush will make a selection, not an effect.

Refi ne the selection

04 Use the plus and minus brushes from 
the top-left of the selection to refi ne it 

should you need to. The non-destructive 
adjustments you made can be seen in the 
Layers panel in Expert mode.

Paint the edit

03 Click on the sky and, with the mouse 
button still pressed down, move all 

over the sky. The Smart Brush not only selects 
the sky for you, but also adds a bit more blue 
to the selected area. 

What’s straight?

02 Click and hold at the end of 
something you know is vertical or 

horizontal and move the mouse so that 
the line runs along the straight edge. 
Making the line longer may help you see 
more clearly. Release the mouse.    

EDITING
Enhance your landscapes
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Edit Raw images Utilise the power of Raw

Bring out the shadows

02 This image may look a little dark but 
there’s a lot of detail we can regain. 

Bring up the Blacks and Shadows to reveal the 
detail there. If you’re comfortable with 
histograms, you’ll notice there’s one here too.

Open images in ACR

01If you shoot in Raw you’re capturing a 
much wider luminance range and can 

edit in a Raw editor. Elements has its own 
editor and if you click on a Raw fi le, it should 
automatically open in Adobe Camera Raw.

Add some warmth

04 To get a nice warm sunset glow, we’ll 
bring the Temperature slider up to the 

right to around 7800. If you want to cool down 
a shot and add blue tones, move it to the left. 
Click Done. 

Get some detail

03 Move down to the Clarity slider and 
knock that up to bring out some detail. 

Also add a little more Saturation and Vibrance 
here to punch up the colours, but don’t take 
these too far. 

Crop for better 
composition

Refi ne the crop 

03  When you release the mouse a 
bounding box appears. There are 

nine handles on the box, each of these 
can be clicked and moved to change the 
crop. Click the tick at the bottom of the 
bounding box to accept the crop.

Pick the Crop tool

01 The Crop tool is at the bottom of 
the tool panel. The options for this 

tool are quite extensive. There are various 
ratios, sizes and even suggestions on how 
to crop. You can crop freehand too – 
that’s what we’ll do here.

Draw the crop

02 When cropping, click and drag out 
the crop, from corner to opposite 

corner. If the shape isn’t one you want, 
check the settings at the bottom. You 
may have a ratio set from the last time 
the tool was used.

Share your shots at: photoforbeginners.com
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Enhance your landscapes
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Learn how to put some blur in your picture to 
add speed, direction and excitement

Achieve post-
editing motion blur

WHAT YOU’LL NEED…
Photo-editing program

An image to blur

WE USED…
Photoshop CC

YOU COULD USE…
Photoshop Elements

After Effects

five 
minute 
project

EDITING
Achieve post-editing motion blur 

AFTER
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Experiment with various 
angles and strengths in 

the Radial Blur fi lter option 
to produce the correct 
result for your image.

Try out different 
options



Duplicate your layer

01Load your image into Photoshop. To
begin, we want to duplicate the shot as

we will need the original later. You do this by
going to Layer>Duplicate Layer or press Cmd/
Ctrl+J as a shortcut.

Locate the filter

02Photoshop has many filters that you
can apply to your images, all kept in

the Filter menu at the top. In this instance, we
are going to go Filter>Blur>Radial Blur to
create our motion effect.

Adjust the blur settings

03Change the Blur Method to Zoom,
Quality to Best and adjust the Blur

Centre by dragging the cursor in the direction
your subject would be coming from. The
Amount slider is best at 20. Click on OK.

Adjust the opacity

04To bring some of the detail back to the
image so that we have a focal point,

we can adjust the opacity of the layer using
the slider bar just above the layers. This
brings back the original image slightly.

Create a layer mask

05To have a concentrated area of detail,
yet still keep the movement effect, we

need to create a layer mask by pressing the
button underneath the layers that looks like a
circle in a rectangle.

It’s very easy to get too comfortable with the
way an image looks, especially when you
photograph the subject on a regular basis. If
you attend a sporting event such as a motor
sport, track and field or cycling, the default
approach is to capture it as a freeze-framed
moment in time. However, what if we want our
pictures to portray a feeling of movement
within the frame rather than just photographing
what is in front of us?

You can do this in-camera using a method
known as ‘panning’. This is where you move
your camera in time with the subject whilst
focusing on one point and using a slightly
slower shutter speed. But what if you wanted
to add this effect afterwards or revisit an
image in your back catalogue?

Photoshop has various filters that can be
applied to create a blurred effect to your image
and it is very easy to just add a Motion Blur
filter. However, the best effect is achieved with
the Radial Blur filter, because it allows us to
work in a more three dimensional environment.
Whether you want to show direction within the
image or add some creative value by making
your subject look as if they were travelling at
high speed, this technique can help you
achieve that.

In these steps, we’ll show you how you can
add this dynamic effect and mimic the
in-camera technique of panning so that you
can create a feeling of movement. We have
used Photoshop CC but you can use
Photoshop Elements and CS versions, too.

Lets get moving Using the Radial Blur filter

Bring back the detail

06Press ‘B’ to activate the brush and set
the colour to black. Reduce the

Opacity (at the top of the screen) and with the
layer mask thumbnail selected, paint over
areas to bring back into focus, like the face.

EDITING
Achieve post-editing motion blur
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How to get your snaps up to scratch and 
looking their best before you print  

Prepare your 
photos for print 
Photo prints are a lasting keepsake and a 
fantastic way to share your recent 
adventures with family and friends. 
Whether you want them to adorn your walls 
in frames or fi ll up the family album, they’re 
quick and easy to produce at home or even 
order from an online print service.  

But before you rush in and prepare the ink 
and paper, it’s important to ensure your 
shots are actually ready to print. For the 

best results there are a few necessary 
editing steps you need to take using your 
preferred computer software. 

In this easy-to-follow tutorial, we’ll show 
you how to get your shots up to scratch in 
Photoshop. You’ll discover how to change an 
image’s colour profi le from RGB to CMYK to 
ensure that prints match up perfectly with 
what you see on screen. You’ll also learn 
how to enhance contrast, colour hues and 

crop in for a better composition. We’ve even
covered sharpening shots using the
Unsharp Mask tool, as well as how to adjust
the image dimensions and resolution before
you save and print.

And if you also happen to be keen to
share your images online, check out the
three-step mini tutorial on the right, as we
explain how to resize and optimise your
photos for the web.

WHAT YOU’LL NEED…
Start image
 Editing software

WE USED…
Photoshop

YOU COULD USE…
Elements
Gimp

Mode
Ensure you 
change your 
photo’s colour 
space to CMYK 
before printing via 
Mode from the 
Image menu

Layers palette
All of your
adjustment layers
that enhance
contrast and colour
hues will appear in
the Layers palette.
These will need to
be flattened before
you save
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Image Size
Check your image is 
the correct size and 
resolution from the 
Image Size dialog 

SHARING



Optimise your images Adjust shots so they’re ready for print

Crop in closer

04Strengthen the composition by clicking
on the Crop tool and selecting the

entire image. Hold down Shift to constrain
proportions as you drag in one of the corners.
Move the selection and then hit enter.

Sharpen the shot

05Always sharpen before you print. Select
the Background layer and go to

Filter>Sharpen>Unsharp Mask. Increase the
Amount slider to 100% and then slowly drag
the Radius slider up between 1.2-1.8 pixels.

Change colour space

01Before you edit, go to Image>Mode>
CMYK Color. CMYK is the preferred

choice for most printers; your image may look
a little washed out now but we’ll show you
how to enhance it in the next steps.

Increase contrast

02Enhance contrast by selecting Curves
from the ‘Create new fill or adjustment

layer’ tab at the bottom of the Layers palette.
Add two anchor points at either end of the
diagonal line and pull them into a subtle ‘S’.

Enhance colours

03To punch up the colour tones, select
the Hue/Saturation tool from the

Adjustment layer tab. Work through the colour
hues in the Master drop-down menu. Slowly
increase the Saturation slider for each hue.

Resize shots
for the web

Adjust image size

06Resize your image to fit the print
dimensions via Image>Image Size.

Select Constrain Proportions and input the
width and height within the Document Size
section. Ensure Resolution is set to 300ppi.

Flatten and save

07Before you save, flatten all of the
working layers via Layers>Flatten

Image. Now go to File>Save As and save the
image in JPEG format. You can now print your
photo at home or via an online service.

Optimise for the web
Now go to File>Save for Web & Devices. Ensure
JPEG is selected, Quality is set to Very High and
80 with the Optimized box ticked.

Adjust Image Size
Go to Image>Image size. In the dialog box change
the Width within Pixel Dimensions to 600 pixels;
the Height will adjust automatically.

Convert colour and save
To ensure colours appear correct online, select
Covert to sRGB. You can also select to include
Copyright and Contact info. Now select Save.
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Use Canon’s irista site to keep photos safe, 
organise them and share with friends

Store your 
images online
There are many websites available that let you 
store photos online, and it’s a great way to back 
up your precious memories, as nothing could feel 
worse than losing shots from a momentous 
event. Irista is an image-hosting website from 
camera manufacturer Canon, that is designed to 
become an online home for storing and sharing 
your photo collection. 

There are three ways to get your photos on 
irista, including a desktop uploader for Windows 
and Mac, a browser-based upload tool, and by 
importing images from social media sites 
Facebook and Flickr. You can also use basic 
organisational tools such as adding tags and 

creating online albums. Sorting photos is easy, 
arranged by camera type, date, or social networks 
the photo has been shared with. 

Unlike other photo storage and sharing 
applications, you don’t have to share your images 
on social media at all if you don’t want to, so the 
service is a very secure and private method of 
keeping precious content safe. When you click on 
a photo to enlarge it, you’ll be able to view all of 
the data for that specifi c photo, such as what 
camera and settings you used. The signing up 
process is simple and the fi rst 10GB of photo 
storage is free, giving you more than enough 
space to get started with.

WHAT YOU’LL NEED…
Computer
Internet browser
Photos to share

WE USED…
MacBook Air

YOU COULD USE…
A Windows PC with 

an internet connection
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Share images
You can share 
photos quickly to 
Facebook and Flickr, 
but currently there’s 
no option to send 
them via email

Quick access
Your photos can be downloaded 
from the irista website at any time 
by clicking the cloud icon

Picture info
When you click on an image, you’ll
be able to view the settings and
camera used for the shot

SHARING
Store your images online



Keepmemories safe Use irista to store photos

Get selecting

04Either drag photos into the upload
window, or click ‘Or find photos’ to

select them from a specific location. You can
add up to 30 images at a time. Close the
upload window when you’ve finished.

View uploaded images

05Select ‘Your photos’ from the top menu
bar. From here you can see your recent

uploads and also tag, delete or share photos
as well as create albums. Click on an image to
see it in a larger size.

Register yourself

01When you visit the irista site, you will
be asked to register. You can link it to

several options including Facebook and Gmail.
Choose the account you use most often, as
the app accesses your friends list and photos.

Add final details

02After you link your new irista account,
you will need to fill in details such as

your region and time zone, then click ‘Sign me
up’. Untick the bottom boxes on-screen if you
don’t want to receive email updates.

Start uploading

03Click Upload on the top menu. You can
add photos online, from your social

media accounts or by downloading a desktop
uploader. For first time users it’s easiest to
choose the ‘Upload via web’ option.

Websites to
share shots

Get sharing

06On the right of the screen, click ‘Share
this photo’, and select the platform

you want to use. You can then fill in the image
name, description and where you’d like it to
be shared to, such as your Facebook timeline.

Manage your account

07Click ‘Manage subscription’ in the top
right-hand corner to see how much

storage space you have left. You can also
change your details, notification preferences
and link more social media accounts.

500px
500px allows 20 free uploads a week, and
enables you to licence your photos, as well as
share them with others on social media.

Flickr
Flickr gives the option to share photos publicly
and privately. There’s also an app so you can
manage your photos from mobile devices.

DropShots
With an easy to use online editor, DropShots lets
you control who views your content. Images are
organised by the date they were taken.

3OF THEBEST…
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SHARING
Store your images online

Share your shots at: photoforbeginners.com

http://photoforbeginners.com
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Contact us with your questions at pfbteam@imagine-publishing.co.uk

pfbteam@imagine-publishing.co.uk

Photo needs rescuing?
Email it to our experts

Tiny creatures make great 
subjects for macro shots 
because they have fascinating 
and intricate details that look 
amazing up close. However, as 
they are always on the move, it 
can be very diffi cult to get the 
perfect shot. Sharpening in 
particular is usually needed in 
order to really bring out the 
detail in close-ups, and if you 
want to get even closer, you can 
crop in a bit, too.

My new favourite hobby is 
taking photos of the insects 
I fi nd in my garden. It can be 
a challenge when they don’t 
stay still but I’ve managed to 
get some good shots. I think 
this one in particular has 
potential, but any ideas how 
I can improve it?
Mary Reed, email

Enhance detail  Fix a soft and dull shot with Photoshop Elements

How can I improve my macro photo?

C

Soft details
The intricate details of the bee
could do with sharpening, as in
the current state they look a little
soft and fuzzy

A
Dull colours

The flower and insect suffer from
a lack of impact and need a
boost of saturation to make
them true to life

B
Underexposed

Overall, the shot needs 
brightening up a touch as it 
looks quite dark and shadowy 
due to being underexposed 

C

A
B

01 Brighten it up 
Go to Enhance>Adjust Lighting>Brightness/

Contrast and increase the Brightness slider to fi x 
underexposure. You can also boost the Contrast.

02 Sharpen detail 
Go to Enhance>Unsharp Mask and click on 

your subject to locate it in the preview box. 
Increase the Amount slider to sharpen. 

03 Boost colours
Now go to Enhance>Adjust Color>Hue/

Saturation and increase the Saturation slider to 
make the colours in your photo appear more vivid.

mailto:pfbteam@imagine-publishing.co.uk
mailto:pfbteam@imagine-publishing.co.uk
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Fill inshadows
Cover some card in tinfoil to make
your own reflector. Use it to bounce
light back into any harsh and
unflattering shadows across your
subject’s face.

3 OF THE BEST…
Tips for 
amazing 
close-ups

01 Set your mode 
Some cameras have a dedicated 
macro mode, but if you want more 
control use aperture priority mode. 
Set a wide aperture (small f-number) 
to create background blur.

02 Focus manually 
The best way to keep your close-ups 
sharp is to use manual focus. Switch 
to MF on the side of your lens, then 
twist the focus ring around until your 
subject appears sharp.

03 Check the shot
After you have taken the shot, go to 
playback mode and check it. Make 
sure you zoom in on it to really check 
it’s sharp, and take the photo again if 
it looks out of focus. 

I really enjoy taking photos of my friends
and family to print out and display on
my walls at home, but I’m always a little
disappointed with the results. I’d love to
know how to make my shots look more
impressive and flattering, but I only have a
basic camera and can’t afford lots of fancy
lenses and lighting accessories. Is there
anything I can do to improve my photos
without spending a fortune?
Joan Lloyd, via Facebook

Photography is known for being an expensive 
hobby, but it really doesn’t have to be. There 
are lots of ways that you can improve your 
shots using common household items and 
cheap materials. For example, instead of pricey 
professional studio lights, use a desk lamp to 
light your shot, moving closer to your subject 
for a brighter effect. If you’re struggling to fi nd 
an attractive backdrop, just fix a big sheet of 
colourful paper to a wall or stick some plain white 
paper to a window for a soft backlight.

How can I take better portraits?

Softenyour flash
This tip is really effective; bounce the
light from your pop-up flash off a
piece of white paper or diffuse it with
translucent paper in order to soften
its harsh effects.

Cheap home fi xes  Improve portraits without splashing the cash

Use a makeshift wind machine
To achieve a more glamorous effect, 
use a desk fan as a wind machine, 
positioning it in front of your subject 
to create some subtle movement in 
their hair.  

It’s easy and cheap to take 
fl attering portraits 
at home

http://photoforbeginners.com
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Is there a way to zoom out of a photo
after you have taken it? I’ve got some
nice landscape photos I’ve taken, but I’ve
decided they would look better with more
sky in the frame. Is there an editing trick I
can use to fix it?
George Royle, via email

Zooming in for a close-up is great for drawing
attention to specific details but sometimes it’s nice

to give your subject more space. If the backdrop
of your shot is relatively plain then you can easily
zoom out of your shot later using editing software.
However, this is much harder if the background has
a lot of patterns, textures and detail. Therefore, it is
best to always be too zoomed out rather than too
zoomed in, as all editing programmes make it easy
to crop in to any shot. If you just want to extend a
bit of plain blue sky though, then follow these steps
to find out how.

Can I add more backdrop to my shot?

Like
This month we

Post your photo to 
our Facebook page 
and we’ll share it 
with the world

Search for ‘PFBMag’ 

Extend the background Zoom out of your shot using Photoshop Elements

Ray Breeze
An exaggerated HDR effect really adds 
drama to a stormy scene

Bikash Basnet
Fast shutter speeds help you capture sharp 
shots of majestic birds in fl ight

Sandra Bailey
Still life shots are particularly interesting 
when they have meaning or a theme  

Jason Garton
The zoo is a fantastic place to photograph 
adorable wildlife shots like this

Adjust the canvas
Go to Image>Resize>Canvas size and 
input a new height or width 
depending on how you want to 
extend. Adjust the anchor points to 
set the direction, too. 

Select the background
Select the Rectangular Marquee tool 
and drag a box over the background 
you wish to extend, making sure it 
doesn’t include your main subject or 
any busy detail. 

Extend your shot
Now it’s just a case of using the 
Move tool to drag one edge of the 
box towards the edge of the canvas 
and extend the background as far 
you like. 

Zooming out makes for a 
more spacious image and 

can really help improve 
your composition
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Get to know your 
camera in 5 minutes
Your quick-start guide to help you master your kit now

CAMERA ICONS EXPLAINED Choose the correct setting with this guide

+

  Delete – found 
on all cameras

Playback – use
to review photos

Flash – choose
to switch on/off

Flash off – the 
fl ash won’t fi re

Zoom in on 
your photos

Zoom out of 
your photos 

–

+ –

Drive modes,
including Burst

Metering
modes

Zooms lens out
for wide-angles

Zooms lens in
for close-ups

Exposure
compensation

Video mode on
stills cameras

Self-timer for 
self-portraits 

Image 
stabilisation

Function button 
– for shortcuts

Diameter of lens
– found on barrel

Macro or close-
up modes 

Night-time/
low-light scenes

FnW
T Ø

A TO

Landscape
Boosts the saturation 
in blues and greens 
for really vivid shots

Sports
Uses a fast shutter 
speed to capture 
blur-free movement

Program
Easily customise
settings like ISO and
white balance

Auto
Let your camera do 
the hard work for you 
in Automatic mode

Shutter 
Priority

Select just the shutter 
speed in this mode

Portrait
For super-fl attering 

people shots with 
blurry backgrounds

Aperture Priority
Select the aperture while 

the camera picks the 
shutter speed for you

Manual 
Take control in this 

mode and pick your 
own settings

JARGON BUSTER
Aperture: Affects the amount of your image 
that is in focus – the ‘depth of fi eld’

CSC: Compact System Camera

DSLR: Digital Single-Lens Refl ex camera

Drive mode: Continuous or Burst mode, 
single shot and self-timer

Dynamic range: The term used to refer to 
the amount of detail present in the highlights 
and shadows

Exposure: A balanced exposure has detail in 
light and shadow areas alike

Exposure compensation: Adjusts the 
tonal range of your photo, lighter or darker

Focal lengths: Wide-angle – a wider-angle 
of view than normal, eg 28mm. Telephoto – a 
magnifi ed view of subjects in the distance, 
such as 200mm

Focus: Autofocus means your camera focuses 
for you; Manual puts you in control

ISO: Refers to how sensitive your camera’s 
sensor is to light. ISO also affects the visible 
grain, or ‘noise’, in a photo

LCD: The display screen on the rear of the 
camera used to compose images

Live View: An electronic view of the scene in 
front of the lens

Metering: Refers to the way the camera 
reads the light in the scene

Megapixels: Number of pixels on the sensor, 
measured in millions

Noise: Refers to the visible digital grain 
photographs sometimes exhibit

Shutter speed: Fast speeds freeze action, 
while longer ones blur any motion

Viewfi nder: Optical – shows you the view 
through the camera lens and is good for accurate 
framing. Electronic – shows the view on an LCD in 
the viewfi nder

White balance: Affected by the ambient 
light, the white balance can be altered to ensure 
a natural colour result

Zoom: Optical – the magnifi cation provided by 
the camera lens. Digital – a camera crop factor

Remove the lens

01 Remove the old lens by 
pressing the button next to 

it and then gently twisting the lens 
anti-clockwise to unscrew it. 

Line it up

02 Remove the new lens’s rear 
cap and then line up the 

red or white markings on the lens 
and camera body. 

Fix in place 

03 Once lined up, twist the 
lens clockwise until you 

hear a click telling you that it has 
locked into place. 

Change your lens How to remove and attach lenses

Mode dial
Shutter 
release Hotshoe

Flash
Lens

Lens 
release

Menu

LCD screen

Controls

Viewfi nder

Zoom

http://photoforbeginners.com


WHAT’S THE KIT LENS LIKE?
The supplied 12-32mm lens we tested is very compact, just like the 
camera, but doesn’t offer much zoom reach for getting close-ups of 
distant subjects. However, Panasonic currently offers 22 different 
compatible lenses for this camera, including telephoto zooms. 

BUY
THIS IF…

You want 

advanced 

functionality in a 

little camera

Panasonic LUMIX 
DMC-GM5
£699/$799 (with 12-32mm lens) | 16 megapixels | Electronic viewfinder | Wi-Fi

Does this tiny CSC still manage to pack a lot on board?
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UPGRADE



An electronic viewfinder is usually the first thing to
be removed from a camera in an attempt to make it
smaller, but Panasonic decided to keep this useful
edition on its new miniature compact system
camera. Although small, the GM5’s EVF gives a clear
view of the scene without any nasty reflections, and
automatically switches on when it senses your eye
– and your finger if you’re not careful. However, it
also leaves no room for a built-in flash, so you have
to remember to carry around the supplied external
flash that attaches to the hotshoe and adds a bit of
bulk to the camera.

The LCD is unfortunately fixed, so you can’t tilt it to
help with framing from awkward angles, and images
only stretch across the whole screen if you shoot in
a really wide format. However, it does feature touch
control, making the camera very quick and easy to
use. Some of the onscreen controls are little small
and fiddly for those with large fingers, but luckily
there are plenty of buttons and dials, too. As well as
a feature-packed mode dial with an impressive range
of manual and scene modes, there’s also a separate

Ideal for those looking for control in a compact body.
However, it’s quite pricey, especially in comparison to
competitors and when considering its flaws.

VERDICT

dial just for focus modes. Focusing is very quick,
launching into action as soon as you look through
the viewfinder or half-press the shutter, and burst
mode records a speedy 5.8 frames per second.

The only thing that will slow you down is the fact
that you have to manually extend the lens before you
can start shooting, and this doesn’t automatically
switch the camera on as it does with some
competitor models. Surprisingly, the GM5 is also
missing the NFC compatibility found on many other
Panasonic cameras, but the Wi-Fi function is easily
activated by scanning a QR code on screen.

Despite some minor flaws, this stylish little
camera does offer lots of easy control for beginners
and superb image quality with vibrant colours and
plenty of detail up until the very end of the ISO scale.

Easy control and fantastic
image quality

Viewfinder aids the framing
of images

Flash is bulky and external,
instead of built-in

Manually extending the lens
slows you down

Portraits
A variety of portrait scene modes will
help you get flattering shots

Landscapes
Colours are vivid and panorama mode
lets you capture the entire scene

Sports
Quick to focus but you might miss a
shot when extending the lens

Low light
Low-light shots have little grain, even
when shooting handheld

Macro
The kit lens won’t focus up very close,
but macro lenses are available

Megapixels 16MP
Enough pixels for producing high-quality
large prints of your images

Zoom By lens
The 12-32mm kit lens doesn’t offer
much zoom, but other lenses are
available to improve this

Shutter speed 1/16000-60sec
An excellent range for freezing action
and shooting in low-light conditions

ISO sensitivity 100-25600
Plenty of sensitivity for producing clear
and crisp low-light shots

Exp. modes 23 scenes, plus Auto,
Program, Manual, AP and SP
A fantastic variety for beginners who
want more control over their images

Aperture By lens

Flash modes Auto, RE, Fon, Foff, SS

Weight 211g with battery

Dimensions 98.5 x 59.5 x 36.1mm

Batteries Li-ion

Storage SD / SDHC / SDXC

Screen 3 inches

HOW GOOD IS IT FOR…

TECHNICAL INFO

THE PROS & CONS

Left

Face value 
The camera features a stylish 
yet subtle retro design and 
easily slips into a coat pocket

Clean results 
Images capture bright colours and 
accurate detail, with noise handled 
well until ISO 6400. There are also 
lots of creative fi lters for 
transforming your photos. 

Right

Tricky navigation 
There’s no grip for a secure 
hold and its small size makes it 
a little fi ddly for big fi ngers

UPGRADE
Panasonic LUMIX DMC-GM5

Share your shots at: photoforbeginners.com Photography for Beginners    45
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HOW EASY IS IT TO CAPTURE 
SELF-PORTRAITS?
The vari-angle LCD can be pulled out and flipped 
around so that you can frame portraits easily. There 
is a second shutter release button on the front so 
that you can take photos with one hand, while 
Gesture Control makes it possible to shoot photos 
and videos by waving your hand.

BUY
THIS IF…

you want 

sharing options 

for your selfies

Nikon COOLPIX 
S6900
£200 | 12x optical zoom | 16MP | Built-in Wi-Fi

A novel compact that boasts a built-in stand for 
shooting better self-portraits

UPGRADE
Nikon COOLPIX S6900
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Self-portraits, or ‘selfies’, can be hit and miss. The
photographer’s outstretched arm ends up looking
like a fleshy lead-in line and compositions are often
lopsided at best, but Nikon’s S6900 is designed to
solve our selfie problems. It has a fully articulating
screen that can be flipped to face forward, and
there’s even a shutter release button on the front of
the camera as well as the top.

The convenience and ease with which it takes
portraits puts it in the same league as most
smartphones, helped by its pocketable build and
features such as self-wide mode, which combines
several shots to create group pictures, as well as
self-collage, which combines nine different faces
into a single photo-booth style image. A great model
for social snappers, this camera also comes with
built-in Wi-Fi and NFC connectivity so you can share
your shots.

This camera can also tackle a variety of other
subjects, with a 12x zoom for close-ups, 20 different
scene modes and the option to add over 30 image
effects. It couldn’t be simpler to use either, as there
are very few buttons to contend with. The screen is

The Nikon S6900 may be the answer to our selfie
prayers, but average image quality sadly lets this
compact camera down.

VERDICT

touch sensitive so those with smartphones will feel
very much at home, and there is the added bonus
that the screen can be turned into a stand for
propping up the camera either horizontally or
vertically. This makes it easier to take self-portraits.

Image quality is pleasing in good lighting
conditions, however when the night draws in the
S6900 struggles to capture enough detail.
Exposures are fairly accurate and images exhibit
natural-looking colours, but focusing can be slow
and sometimes fails to hit the mark when
photographing macro shots. Ultimately, there are not
enough advantages to purchasing this camera over
a capable smartphone. Most mobiles can match the
image quality on offer, and upload the shots directly
to social networks after, but it would suffice as a
compact for holidays and events.

It comes with a built-in
stand for support

The touchscreen LCD is
very responsive

Low-light images lack detail
once you hit ISO 400

Focus and overall quality
is average

Portraits
Portrait and Glamour modes help create
flattering portraits

Landscapes
The wide-angle lens packs a lot into the
scene with accurate colours

Sports
Sports mode helps to capture the
action but blurring does occur

Low light
We found noise starts to creep in at a
relatively low ISO of 400

Macro
You can focus from 2cm away but detail
is disappointingly lacking

Megapixels 16MP
Plenty of megapixels for producing large
prints with detail

Zoom 12x optical, 4x digital
A focal range of 25-300mm is suitable
for landscapes and close-up captures

Shutter speed 1-1/2000 sec
Freeze fast action or slow things down
to four seconds in Fireworks mode

ISO sensitivity 125-1600 (3200
and 6400 available in Auto mode)
A broad range for all lighting situations

Exp modes 19 scene modes, Auto,
Scene auto selector, Special effects,
Portrait, Glamour mode
Plenty of auto-friendly functions

Aperture f3.3 - 6.3

Flash modes TTL auto flash with
monitor preflashes

Weight 181g with battery

Dimensions 99.4 x 58.0 x 27.9mm

Batteries Lithium-ion

Storage SD / SDHC / SDXC

Screen 3 inches

HOW GOOD IS IT FOR…

TECHNICAL INFO

THE PROS & CONS

Left

Mode help
Twenty scene modes adapt to 
different scenarios, and there 
is a macro mode available but 
detail isn’t as clear as we 
would have liked

Right
Filters
There are a variety of fi lters 
that let you get creative with 
shots, like this Toy Camera 
effect applied here

Right

Screen
The three-inch 
touchscreen is very 
responsive when 
altering settings or 
taking a photo

UPGRADE
Nikon COOLPIX S6900
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Kitessentials
Improve your imagery with this selection of 
helpful photography accessories
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1 Your Family in Pictures 
Price £15/$20
This useful photography book is 
aimed at parents, and is full of 
ideas to help improve family 
portraits and shots of everyday 
life. There are seven chapters 
and 140 colour pages, which 
cover all age ranges of children. 
Each photographic subject 
comes with an explanation and 
well-printed example photo, and 
there is technical advice on how 
to set up your camera. The 
author covers every theme you 
might ever want to photograph in 
family life, giving guidance on 
how to compose and capture 
each shot. The small paperback 
format makes the book easy to 
hold and perfect for fl icking 
through. It’s also available as an 
eBook, and you can visit www.
amphotobooks.com for more.

ACCESSORIES
Kit essentials

http://www.amphotobooks.com
http://www.amphotobooks.com
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4 Miggö DSLR Strap & Wrap  Price £39/$50

Miggö’s (www.mymiggo.com) multifunctional 
camera protector quickly unzips down the 
middle, so that you can use it as a strap to carry 
your camera across your chest. You will be able 
to store the lens cap in the inner pocket when 
shooting, and the cover wraps snugly around a 
medium DSLR to prevent it being scratched while 
inside an everyday bag. The product attaches 

fi rmly via the tripod screw on the camera body, 
allowing the user to still connect a tripod 
while the Miggö is attached, and the Neoprene 
and Lycra material hugs the camera. It feels well 
made, and there’s a range of fun prints to 
choose from. However, for the same price you 
could buy a 
camera bag.

2 Overboard waterproof zoom lens 
camera case  Price £24/$48

Overboard’s (www.overboard.com) camera 
case is a good solution for photographing 
water-based photos, when you don’t want the 
worry of damaging your camera. It fi ts compact 
cameras with a zoom lens of 2.8cm or less, 
though it can be fi ddly to get the camera inside 
the case. The build quality feels a bit fl imsy, but 
it’s useful that the case fl oats. You can also still 
access and press down your camera’s buttons 
easily, with the comfort of knowing that the grip 
switches will keep it dry for up to six metres 
underwater. This lightweight case could have a 
more robust build quality for its price, but it 
would be useful to take on holiday, to avoid 
sand, dirt and water damage.
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3 thumbsUp! Selfie Phone Finder  
Price £20 (approx. $31)

If you often lose your phone or keys, this small, 
practical gadget from thumbsUp! (www.
thumbsupuk.com) is an easy way to link the 
two, via Bluetooth. You can also use the device 
as a remote, to activate your phone camera’s 
shutter from up to 10 metres away and the 
iTracing App that links the tag to your phone is 
free to download. Operation of both the fi nder 
and software is simple, and this no frills gadget 
is easily attached to keys, with a low power 
consumption that means the battery shouldn’t 
need changing often. The device is more 
valuable when you consider that the app is free, 
and it doubles up as a shutter remote, but it 
still seems pricey for what it is.
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Top landscape 
composition
tricks

Includes
 Step-by-step shooting advice 
 Image editing made easy 
 Fun ways to share your shots
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From using leading lines to the rule 
of thirds, learn how to shoot stronger 
vistas with our in-depth guide

Find us on Apple’s Newsstand Please note topics are subject to change
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